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One of the first obstacles was getting the 
appropriate partners convinced (as we were) 
and on-board as quickly as possible. We needed 
two key partners: one to increase the Internet 
bandwidth to accommodate the expected traffic 
during the Fair, and the second to provide 
robust exterior-rated reliable business-class 
network hardware (i.e., wireless access points 
strategically position across the Fair grounds 
campus) to make the mesh network and 
connectivity possible. 

One of CTSi’s Internet partners, Metronet, 
quickly joined in on the vision and stepped up to 

assist. Beyond agreeing to provide an extra 1GB of Internet bandwidth during 
Fair week, Metronet also jumped in and donated a significant amount of fiber 
cable and installation labor to install this cable. Without Metronet, no amount 
of equipment or configuration could have made this project as successful as it 
was—and in the timeframes required.

The second CTSi key partner was Cisco Meraki. CTSi knew that Cisco Meraki 
equipment was the right fit for its reputation in quality, reliability, performance 
and ongoing superior cloud management. The network complexities for this 
type of project are intense and CTSi new that Cisco Meraki would be the 
right route given the compressed timeframes. The Cisco Meraki team came 
through with significant discounts on equipment, aggressive financing options, 
expertise in overall network design/engineering to complement and work with 
CTSi engineers to enable a successful build-out. Without this help, the project 
may have stopped before it began.

By the time we received the final green light to go from the Fair board, there 
was less than two weeks left before the Fair—and the July 4th Holiday was 
smack dab in the middle of the 2nd week! By the time equipment was ordered 
and shipped—even with rush shipping, there would only be one (1) week 
remaining for actual install time. Impossible!

Within one week of the Fair’s opening, we were still waiting on delivery of the 
cable required to begin work. Brett explained, “if the situation were reversed 
and we had the cable with no boxes, we could hang the cable and drop in the 
equipment later, but with no cable, we couldn’t even start.” Due to the 4th 
of July interruption of normal shipping schedules, our tracking information 
showed the cable would not arrive until end of day on Wednesday (day 
after the 4th), now leaving only four days for installation. Every lost moment 
made the possibility of success less likely. With some creative thinking, quick 
investigation and sacrifice of personal time, a team member located the cable 
needed at a location a few hours away, placed the order, coordinated pick-
up of the cable within business hours and then made the trip to pick up the 
cable. This gave us back an installation day which was absolutely necessary for 
completion of the project in time for the Fair. 

With the spoiler at the beginning of this story, you know the end already.  
Our team pulled together with early mornings and late nights to complete 
a seemingly impossible task. The Fair went off well with more than 10% of 
the people walking through the gates connecting and utilizing the wireless 

- Story continued from the front page.
network. We met friends walking around and vendors who thanked us for 
making it possible for them to get their message out to visitors. Fair Staff 
who spent the week on-site were able to connect home and make their stay 
that much more comfortable. I’m sure Instagram stories and Facebook posts 
helped to connect distant friends and enhanced the Fair experience. We were 
thrilled to have been a part of it.

Brett’s faith deeply frames how he looks back on this experience: “I believe 
God is interested in us and what we do.” Brett explains, “If we look for it, we 
can see God’s hand as He makes things that seem impossible to us happen, 
even in difficult times.  His only requirement on us was to put forth our best 
and let him do the impossible.”  

As this important new service is related to Brett, we couldn’t help but give a 
little teaser now. Stay tuned for more information coming soon...

CTSi is now providing structured cabling services.
If you need network cabling for new construction, updating cabling during 
a remodel or adding additional network runs/drops to facilitate additional 
wireless access points or device connections, CTSi can now provide this service 
directly. 

If you need structured cabling services in your new building, or 

if you are updating an existing environment, give us a call:

574.268.CTSi [2874]

RECAPPING FAIR WEEK 
THE HEART OF A TECH

In last month’s newsletter we shared the big news that we had partnered with Metronet and Meraki to 
install a campus-wide mesh wireless network. The project was a massive undertaking, and we’re proud 
to say, a success. 

We want to take a moment and reflect on the project at a deeper level. This was particularly important to 
one of our employees, Brett Shaske, who served as both a network design engineer and project manager 
and was also the one who presented the initial idea to our team.   

This is an important story to us because it reflects on who we are: CTSi strives to be a company that values 
the unique part played by each of our staff. The principles and desires that guide us as people naturally 
become part of the company as an extension of the beliefs and standards we hold to as individuals. That 
means our faith and our convictions impact what the company will and will not do.

For Brett, it has been important to acknowledge and understand what the significance of this project has 
been for him.  Mid-June, as he was driving past the Fairgrounds one day, the idea of access to Internet for 
the Kosciusko County Fair came to mind seemingly out of the blue, and despite the many reasons why 
it would be impossible to pull off, he felt a strong sense that it was something he needed to pursue with 
CTSi.

There were many obstacles to a project of this magnitude.  First, we were only a month out from the Fair 
and this kind of project, from start to finish, typically requires at least 30 days to complete. Secondly, Brett 
knew this kind of project would mean a massive investment and commitment from CTSi and our partners. 
After talking through the details with CTSi President, Tim, along with other members of our team, we 
unanimously found ourselves drawn to pursue it.  The opportunity to support the community, and the 
Fairgrounds in this way was compelling.  “Let’s do it!” - the wheels were in motion.

While we thought the idea was a good one (to provide FREE Internet access to attendees of the Fair), the 
next step was proposing the idea to the Fair board who hadn’t asked for the service in the first place.  
Thankfully, when we sat down with the board, to our great delight, they 
also said, “Let’s do it!” And with that decision, we were off and on 
our way.
 
What followed were a series of obstacles, each of which, from 
Brett’s perspective should have halted, delayed or canceled the 
project completely.

- Story continued on the back page.

FREE NETWORK-WIDE
HEALTH CHECK

SPECIAL OFFER

Call Us Today:
574.268.CTSi [2874]

Take advantage of
this special offer 

TO RECEIVE 
A TOP-TO-BOTTOM REVIEW 

OF YOUR NETWORK 
AND COMPUTERS 

With recommendations that will help 
you make the very best decisions to 

move your business forward. 

After conducting this Free 
Assessment, we’ll be able to answer 

your top questions, such as:

• Are your IT systems truly secured from 
hackers, viruses and rogue employees?

• Are your backups configured properly 
to ensure that you could be back up 
and running again fast in a disaster?

• Are you unknowingly exposing your 
company to expensive fines and 
litigation under data breach laws?

• Could you utilize cheaper and more 
efficient cloud computing technologies 
to leverage your investment and make 
it easier to work remotely?

• Are your systems optimized for 
maximum speed and performance? 
(I can tell you, 99% of the computer 
networks we review are NOT.)

TO SIGN UP FOR YOUR 
FREE NETWORK-WIDE HEALTH CHECK

FILL OUT THE FORM AT: 
WWW.CREATIVETECHS.BIZ/FREEHEALTHCHECK

THANK YOU

NEW SERVICE ANNOUNCEMENT

A NOTE FROM CTSI 
We hope you can see the passion and commitment Brett and our team 

have to do what we believe is right, no matter the obstacle. We are 
grateful to have a team comprised of people like Brett who are willing to 

take action even when things look hard.

We wanted to say a special thanks to the KC Fair board members for 
making a commitment to us. We are looking forward to our ongoing 

partnership to enhance the fair experience in years to come.

Finally, thank you to Cisco Meraki and to Metronet for sharing the 
vision with us. We are excited to continue offering the very best services 

possible to our customers together.

KEEP AN EYE OUT FOR OUR WHITEPAPER
We are compiling our data to help you understand how CTSi can 

help to improve your network in the same way.
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CTSI NEWS CUSTOMER SPOTLIGHT
THE FORTUS GROUP
GRAND OPENING OF THE FLATS AT AUSTIN 

CTSi is pleased to announce that Zach Evans, 
has joined CTSi as Process Manager and 
Tech Admin. Zach’s background, skill set, and 
experiences as a certified Project Management 
Professional (PMP)® contribute to the CTSi 
team by increasing efficiencies and refining 
processes which means improved services to 
our customers. Additionally, utilizing his skills 
and experience, he will also be positioned 
as a Tech Admin — a key role that continues 
to differentiate CTSi’s unique approach to 
serving its managed services customers.

“With Zach on our team, our customers benefit from increasingly consistent 
outcomes that are optimized to provide maximum value with greater 
predictability in the quality of services to our customers. Not all technical 
people can do this. CTSi has an edge over the competition in this area 
because of Zach. We can provide a better experience because more efficient 
management of projects allow team members to focus on their strengths. 
Additionally, as a Tech Admin, Zach will contribute in significant ways to help 
keep client technologies and projects reliable, secure, and within standards. 

It’s fun adding a great team member to the team - enhancing who we are 
and what we can do. His addition motivates us forward to continually 
improve our services.” 
  -Says Timothy Poyner, President of Creative Technology Solutions.

To learn more about Zach and to view the full news release, visit:
www.creativetechs.biz/news/zach-evans

NEED FASTER INTERNET?

Call Today: 574.268.CTSi [2874]

NEED BETTER EMAIL, 
BROWSING, PHONE, OR EVEN 

MEDIA STREAMING EXPERIENCES?  
Work with CTSi to evaluate your needs and expectations, then let CTSi 

determine exactly what your ISP can do to make life better for you. 

THIS IS WHAT WE DO! 
AS YOUR TECHNOLOGY PARTNER,

We work to implement the best solution for your business both inside 
and out.  Let us evaluate your internat service AND your internal network 

components and infrastructure. We’ll provide a comprehensive assessment 
and recommendations for your best performance and functionality.

CTSI TEAM ANNOUNCEMENT 
ZACH EVANS JOINS AS PROCESS MANAGER

CONGRATULATIONS TO OUR FRIENDS AT THE FORTUS GROUP!
We are excited to highlight a milestone of one of our customers. Below is a 
recent announcement from The Fortus Group. We are excited for them and 
wanted to share their big news with you. 

Announcement provided by The Fortus Group:

Fort Wayne-based Fortus Group has entered into the greater Dayton multi-
family housing market with a flagship property that should put both it and 
Miami Township on the map in the eyes of renters across the region. The Flats 
at Austin Landing is geared towards the renter-by-choice who desires upscale 
amenities in a walkable environment. Ideally located, with superb access to 
top-tier restaurants, retail (incl. grocery), entertainment, hospitality, offices, 
and interstates, Austin Landing provides an environment unmatched in the 
area.  

“We’re thrilled to invest in Miami Township; the amenities offered at Austin 
Landing are unequalled in the market,” says Fortus President, Christian 
Sexton.
 
Although the first apartments at the Flats were occupied in late 2016, The 
Fortus Group celebrated the official ribbon cutting in June 2017.  The $29 
million project features a private parking garage, swimming pool with a 
splash ledge & pool deck, poolside grilling area, media lounge, fitness center, 
and a dog park. The Flats at Austin Landing offer a vibrancy not before found 
in the area, and should attract residents to the booming Austin Landing 
development.

Learn more at www.thefortusgroup.com

CTSi is our “One Stop” for all of our technology needs. 
We’ve been very happy with our service from CTSi. They know 
us. They know how we are set up. They understand what 
needs to be done. They understand how technology moves 

our business forward. What that means for us is we don’t have to educate 
a tech every time they send someone out to help us. They come in ready 
to solve our problem and help to identify solutions for our next steps.  
If you’re standing on the fence, why? Try CTSi. You’ll be happy you did.

Rod Baker ‑ Chief Financial Officer at The Fortus Group

REFERRAL REWARDS

Register Your Referral:
creativetechs.biz/referral-rewards

HELP US FIND MORE
GREAT CUSTOMERS LIKE YOU!

At CTSi we believe that referrals are the 
greatest form of flattery, and we are 
proud of the fact that many of our clients 
were referred by other happy customers. 
For that, we want to say a big THANK 
YOU for sharing your experience to help 
other businesses and organizations like 
yours. That’s why we created our Referral 
Rewards program.

Think of a friend who could 
benefit from our services.

Fill out our simple online 
form.

Tell your friend about us and 
encourage them to reach out.

Each submission enters you into a monthly 
drawing for a $25 gift card. AND, once your 

referral becomes a customer, receive your choice 
of either $150 cash or $300 in service credit. 

ASK A TECHNICIAN
CREATE A TIMED SLIDESHOW 
WITH APPLE’S KEYNOTE APP
This post was seen on Facebook by one of our 
staff, and we thought it was a good question for 
our Ask A Technician resources. 

More details will be available at the full blog post, 
but we can do this easily with a simple Powerpoint 
file, assuming transitions and animations have not 
been set.

1. With the Powerpoint document open in 
keynote,  select all slides in the Navigator 
(Select View > Navigator if not visible).

2. Click on one slide and chose Edit > Select All.

3. Choose the “Animate” pane on the right side 
of the application.

4. Change “Start Transition” to “Automatically” 
and set your delay time to “6.00 s.” 
So long as all slides were selected, that setting 
will be applied for the entire presentation.

5. Press “Play” to test, and don’t forget to save 
your document. 

Find more helpful tips at 
www.creativetechs.biz/ask-a-technician/

PARTNER SPOTLIGHT
BLUEWAVE
CTSI IS PROUD TO ANNOUNCE A NEW VOIP OFFERING

CTSi is proud to announce a new partnership with Bluewave
Bluewave is a Voice Over IP (VoIP) telephony solution designed specifically for Insurance Agencies. This 
partnership allows CTSi to provide our insurance agency customers with services that leverage the power 
of their agency management software with integrations into their phone systems. As a result, processes 
are enhanced, time is saved, and the overall customer experience is improved. 

Bluewave is not a “one-size-fits-all” solution, but is a solution custom-designed specifically for the insurance 
industry. It is built by professionals possessing deep experience in the insurance industry. And Bluewave 
has the traction needed to last; currently providing service to more than 4,000 agents across the country. 

Here’s a success story from a Bluewave customer:
“All the recommended VoIP solutions out there were basically the same on paper but something 
about Bluewave stood out so we flew to Birmingham to see for ourselves. We knew what we 
wanted, decided it didn’t really exist with the other VoIP providers, so tasked Bluewave with 
creating a custom solution for us. They delivered everything we wanted as promised and on time.”
 

“What really makes us proud of our investment though is their knowledge of our business and telephony. 
They have taught us ways to redesign our business to enhance our customer’s experience we never dreamed 
possible. We now have big screen monitors in each sales room that have created an incredible level of positivity. 
It gives us a way for all staff to see real time performance and is driving teamwork resulting in substantial 
improvements in goal attainment i.e. number of calls answered, reducing queue time, wait time, and abandoned 
calls. Our customers are happier. Bluewave is and will continue to be an integral part of and partner in 
our continued growth.”

 - Ted Todd of Ted Todd Insurance - www.tedtoddinsurance.com 

What this partnership means for CTSi
Our Insurance Agency customers have found a remarkable fit with CTSi. The reason is agencies are looking 
to get in front of technology to find strategic benefits that will contribute to their growth. This thinking 
represents a shift away from the days of printed paper and filing cabinets into fully-integrated customer 
management, from marketing, through sales pipelines, to ongoing policy management and communication. 
Agencies who want to grow understand the need to centralize all of their data and resources, utilizing 
integrations, to improve efficiencies in order to succeed in an increasingly competitive market. 

CTSi always works to find the right solution for each customer. Bluewave and CTSi have a strategic 
partnership that enables the very best services for insurance agencies delivered through a trusted IT 
partner, enhanced by a VoIP solution built to address the unique needs of the insurance industry. With 
this powerful combination of services, insurance agencies can more effectively leverage their technology 
to realize agency growth and solidify their place in the insurance market for years to come.
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CTSi is pleased to announce that Zach Evans, 
has joined CTSi as Process Manager and 
Tech Admin. Zach’s background, skill set, and 
experiences as a certified Project Management 
Professional (PMP)® contribute to the CTSi 
team by increasing efficiencies and refining 
processes which means improved services to 
our customers. Additionally, utilizing his skills 
and experience, he will also be positioned 
as a Tech Admin — a key role that continues 
to differentiate CTSi’s unique approach to 
serving its managed services customers.

“With Zach on our team, our customers benefit from increasingly consistent 
outcomes that are optimized to provide maximum value with greater 
predictability in the quality of services to our customers. Not all technical 
people can do this. CTSi has an edge over the competition in this area 
because of Zach. We can provide a better experience because more efficient 
management of projects allow team members to focus on their strengths. 
Additionally, as a Tech Admin, Zach will contribute in significant ways to help 
keep client technologies and projects reliable, secure, and within standards. 

It’s fun adding a great team member to the team - enhancing who we are 
and what we can do. His addition motivates us forward to continually 
improve our services.” 
  -Says Timothy Poyner, President of Creative Technology Solutions.

To learn more about Zach and to view the full news release, visit:
www.creativetechs.biz/news/zach-evans
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Work with CTSi to evaluate your needs and expectations, then let CTSi 

determine exactly what your ISP can do to make life better for you. 

THIS IS WHAT WE DO! 
AS YOUR TECHNOLOGY PARTNER,

We work to implement the best solution for your business both inside 
and out.  Let us evaluate your internat service AND your internal network 

components and infrastructure. We’ll provide a comprehensive assessment 
and recommendations for your best performance and functionality.

CTSI TEAM ANNOUNCEMENT 
ZACH EVANS JOINS AS PROCESS MANAGER

CONGRATULATIONS TO OUR FRIENDS AT THE FORTUS GROUP!
We are excited to highlight a milestone of one of our customers. Below is a 
recent announcement from The Fortus Group. We are excited for them and 
wanted to share their big news with you. 

Announcement provided by The Fortus Group:

Fort Wayne-based Fortus Group has entered into the greater Dayton multi-
family housing market with a flagship property that should put both it and 
Miami Township on the map in the eyes of renters across the region. The Flats 
at Austin Landing is geared towards the renter-by-choice who desires upscale 
amenities in a walkable environment. Ideally located, with superb access to 
top-tier restaurants, retail (incl. grocery), entertainment, hospitality, offices, 
and interstates, Austin Landing provides an environment unmatched in the 
area.  

“We’re thrilled to invest in Miami Township; the amenities offered at Austin 
Landing are unequalled in the market,” says Fortus President, Christian 
Sexton.
 
Although the first apartments at the Flats were occupied in late 2016, The 
Fortus Group celebrated the official ribbon cutting in June 2017.  The $29 
million project features a private parking garage, swimming pool with a 
splash ledge & pool deck, poolside grilling area, media lounge, fitness center, 
and a dog park. The Flats at Austin Landing offer a vibrancy not before found 
in the area, and should attract residents to the booming Austin Landing 
development.

Learn more at www.thefortusgroup.com
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We’ve been very happy with our service from CTSi. They know 
us. They know how we are set up. They understand what 
needs to be done. They understand how technology moves 

our business forward. What that means for us is we don’t have to educate 
a tech every time they send someone out to help us. They come in ready 
to solve our problem and help to identify solutions for our next steps.  
If you’re standing on the fence, why? Try CTSi. You’ll be happy you did.

Rod Baker ‑ Chief Financial Officer at The Fortus Group

REFERRAL REWARDS

Register Your Referral:
creativetechs.biz/referral-rewards

HELP US FIND MORE
GREAT CUSTOMERS LIKE YOU!

At CTSi we believe that referrals are the 
greatest form of flattery, and we are 
proud of the fact that many of our clients 
were referred by other happy customers. 
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YOU for sharing your experience to help 
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This post was seen on Facebook by one of our 
staff, and we thought it was a good question for 
our Ask A Technician resources. 

More details will be available at the full blog post, 
but we can do this easily with a simple Powerpoint 
file, assuming transitions and animations have not 
been set.

1. With the Powerpoint document open in 
keynote,  select all slides in the Navigator 
(Select View > Navigator if not visible).

2. Click on one slide and chose Edit > Select All.

3. Choose the “Animate” pane on the right side 
of the application.

4. Change “Start Transition” to “Automatically” 
and set your delay time to “6.00 s.” 
So long as all slides were selected, that setting 
will be applied for the entire presentation.

5. Press “Play” to test, and don’t forget to save 
your document. 

Find more helpful tips at 
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CTSi is proud to announce a new partnership with Bluewave
Bluewave is a Voice Over IP (VoIP) telephony solution designed specifically for Insurance Agencies. This 
partnership allows CTSi to provide our insurance agency customers with services that leverage the power 
of their agency management software with integrations into their phone systems. As a result, processes 
are enhanced, time is saved, and the overall customer experience is improved. 

Bluewave is not a “one-size-fits-all” solution, but is a solution custom-designed specifically for the insurance 
industry. It is built by professionals possessing deep experience in the insurance industry. And Bluewave 
has the traction needed to last; currently providing service to more than 4,000 agents across the country. 

Here’s a success story from a Bluewave customer:
“All the recommended VoIP solutions out there were basically the same on paper but something 
about Bluewave stood out so we flew to Birmingham to see for ourselves. We knew what we 
wanted, decided it didn’t really exist with the other VoIP providers, so tasked Bluewave with 
creating a custom solution for us. They delivered everything we wanted as promised and on time.”
 

“What really makes us proud of our investment though is their knowledge of our business and telephony. 
They have taught us ways to redesign our business to enhance our customer’s experience we never dreamed 
possible. We now have big screen monitors in each sales room that have created an incredible level of positivity. 
It gives us a way for all staff to see real time performance and is driving teamwork resulting in substantial 
improvements in goal attainment i.e. number of calls answered, reducing queue time, wait time, and abandoned 
calls. Our customers are happier. Bluewave is and will continue to be an integral part of and partner in 
our continued growth.”

 - Ted Todd of Ted Todd Insurance - www.tedtoddinsurance.com 

What this partnership means for CTSi
Our Insurance Agency customers have found a remarkable fit with CTSi. The reason is agencies are looking 
to get in front of technology to find strategic benefits that will contribute to their growth. This thinking 
represents a shift away from the days of printed paper and filing cabinets into fully-integrated customer 
management, from marketing, through sales pipelines, to ongoing policy management and communication. 
Agencies who want to grow understand the need to centralize all of their data and resources, utilizing 
integrations, to improve efficiencies in order to succeed in an increasingly competitive market. 

CTSi always works to find the right solution for each customer. Bluewave and CTSi have a strategic 
partnership that enables the very best services for insurance agencies delivered through a trusted IT 
partner, enhanced by a VoIP solution built to address the unique needs of the insurance industry. With 
this powerful combination of services, insurance agencies can more effectively leverage their technology 
to realize agency growth and solidify their place in the insurance market for years to come.
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One of the first obstacles was getting the 
appropriate partners convinced (as we were) 
and on-board as quickly as possible. We needed 
two key partners: one to increase the Internet 
bandwidth to accommodate the expected traffic 
during the Fair, and the second to provide 
robust exterior-rated reliable business-class 
network hardware (i.e., wireless access points 
strategically position across the Fair grounds 
campus) to make the mesh network and 
connectivity possible. 

One of CTSi’s Internet partners, Metronet, 
quickly joined in on the vision and stepped up to 

assist. Beyond agreeing to provide an extra 1GB of Internet bandwidth during 
Fair week, Metronet also jumped in and donated a significant amount of fiber 
cable and installation labor to install this cable. Without Metronet, no amount 
of equipment or configuration could have made this project as successful as it 
was—and in the timeframes required.

The second CTSi key partner was Cisco Meraki. CTSi knew that Cisco Meraki 
equipment was the right fit for its reputation in quality, reliability, performance 
and ongoing superior cloud management. The network complexities for this 
type of project are intense and CTSi new that Cisco Meraki would be the 
right route given the compressed timeframes. The Cisco Meraki team came 
through with significant discounts on equipment, aggressive financing options, 
expertise in overall network design/engineering to complement and work with 
CTSi engineers to enable a successful build-out. Without this help, the project 
may have stopped before it began.

By the time we received the final green light to go from the Fair board, there 
was less than two weeks left before the Fair—and the July 4th Holiday was 
smack dab in the middle of the 2nd week! By the time equipment was ordered 
and shipped—even with rush shipping, there would only be one (1) week 
remaining for actual install time. Impossible!

Within one week of the Fair’s opening, we were still waiting on delivery of the 
cable required to begin work. Brett explained, “if the situation were reversed 
and we had the cable with no boxes, we could hang the cable and drop in the 
equipment later, but with no cable, we couldn’t even start.” Due to the 4th 
of July interruption of normal shipping schedules, our tracking information 
showed the cable would not arrive until end of day on Wednesday (day 
after the 4th), now leaving only four days for installation. Every lost moment 
made the possibility of success less likely. With some creative thinking, quick 
investigation and sacrifice of personal time, a team member located the cable 
needed at a location a few hours away, placed the order, coordinated pick-
up of the cable within business hours and then made the trip to pick up the 
cable. This gave us back an installation day which was absolutely necessary for 
completion of the project in time for the Fair. 

With the spoiler at the beginning of this story, you know the end already.  
Our team pulled together with early mornings and late nights to complete 
a seemingly impossible task. The Fair went off well with more than 10% of 
the people walking through the gates connecting and utilizing the wireless 

- Story continued from the front page.
network. We met friends walking around and vendors who thanked us for 
making it possible for them to get their message out to visitors. Fair Staff 
who spent the week on-site were able to connect home and make their stay 
that much more comfortable. I’m sure Instagram stories and Facebook posts 
helped to connect distant friends and enhanced the Fair experience. We were 
thrilled to have been a part of it.

Brett’s faith deeply frames how he looks back on this experience: “I believe 
God is interested in us and what we do.” Brett explains, “If we look for it, we 
can see God’s hand as He makes things that seem impossible to us happen, 
even in difficult times.  His only requirement on us was to put forth our best 
and let him do the impossible.”  

As this important new service is related to Brett, we couldn’t help but give a 
little teaser now. Stay tuned for more information coming soon...

CTSi is now providing structured cabling services.
If you need network cabling for new construction, updating cabling during 
a remodel or adding additional network runs/drops to facilitate additional 
wireless access points or device connections, CTSi can now provide this service 
directly. 

If you need structured cabling services in your new building, or 

if you are updating an existing environment, give us a call:

574.268.CTSi [2874]

RECAPPING FAIR WEEK 
THE HEART OF A TECH

In last month’s newsletter we shared the big news that we had partnered with Metronet and Meraki to 
install a campus-wide mesh wireless network. The project was a massive undertaking, and we’re proud 
to say, a success. 

We want to take a moment and reflect on the project at a deeper level. This was particularly important to 
one of our employees, Brett Shaske, who served as both a network design engineer and project manager 
and was also the one who presented the initial idea to our team.   

This is an important story to us because it reflects on who we are: CTSi strives to be a company that values 
the unique part played by each of our staff. The principles and desires that guide us as people naturally 
become part of the company as an extension of the beliefs and standards we hold to as individuals. That 
means our faith and our convictions impact what the company will and will not do.

For Brett, it has been important to acknowledge and understand what the significance of this project has 
been for him.  Mid-June, as he was driving past the Fairgrounds one day, the idea of access to Internet for 
the Kosciusko County Fair came to mind seemingly out of the blue, and despite the many reasons why 
it would be impossible to pull off, he felt a strong sense that it was something he needed to pursue with 
CTSi.

There were many obstacles to a project of this magnitude.  First, we were only a month out from the Fair 
and this kind of project, from start to finish, typically requires at least 30 days to complete. Secondly, Brett 
knew this kind of project would mean a massive investment and commitment from CTSi and our partners. 
After talking through the details with CTSi President, Tim, along with other members of our team, we 
unanimously found ourselves drawn to pursue it.  The opportunity to support the community, and the 
Fairgrounds in this way was compelling.  “Let’s do it!” - the wheels were in motion.

While we thought the idea was a good one (to provide FREE Internet access to attendees of the Fair), the 
next step was proposing the idea to the Fair board who hadn’t asked for the service in the first place.  
Thankfully, when we sat down with the board, to our great delight, they 
also said, “Let’s do it!” And with that decision, we were off and on 
our way.
 
What followed were a series of obstacles, each of which, from 
Brett’s perspective should have halted, delayed or canceled the 
project completely.

- Story continued on the back page.

FREE NETWORK-WIDE
HEALTH CHECK

SPECIAL OFFER

Call Us Today:
574.268.CTSi [2874]

Take advantage of
this special offer 

TO RECEIVE 
A TOP-TO-BOTTOM REVIEW 

OF YOUR NETWORK 
AND COMPUTERS 

With recommendations that will help 
you make the very best decisions to 

move your business forward. 

After conducting this Free 
Assessment, we’ll be able to answer 

your top questions, such as:

• Are your IT systems truly secured from 
hackers, viruses and rogue employees?

• Are your backups configured properly 
to ensure that you could be back up 
and running again fast in a disaster?

• Are you unknowingly exposing your 
company to expensive fines and 
litigation under data breach laws?

• Could you utilize cheaper and more 
efficient cloud computing technologies 
to leverage your investment and make 
it easier to work remotely?

• Are your systems optimized for 
maximum speed and performance? 
(I can tell you, 99% of the computer 
networks we review are NOT.)

TO SIGN UP FOR YOUR 
FREE NETWORK-WIDE HEALTH CHECK

FILL OUT THE FORM AT: 
WWW.CREATIVETECHS.BIZ/FREEHEALTHCHECK

THANK YOU

NEW SERVICE ANNOUNCEMENT

A NOTE FROM CTSI 
We hope you can see the passion and commitment Brett and our team 

have to do what we believe is right, no matter the obstacle. We are 
grateful to have a team comprised of people like Brett who are willing to 

take action even when things look hard.

We wanted to say a special thanks to the KC Fair board members for 
making a commitment to us. We are looking forward to our ongoing 

partnership to enhance the fair experience in years to come.

Finally, thank you to Cisco Meraki and to Metronet for sharing the 
vision with us. We are excited to continue offering the very best services 

possible to our customers together.

KEEP AN EYE OUT FOR OUR WHITEPAPER
We are compiling our data to help you understand how CTSi can 

help to improve your network in the same way.

 


